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PRINT OR OUTPUT SHARPENING 

From the moment light signals are registered by the sensor, right through to when the 

picture goes to the printer, the image loses sharpness and definition each time it is 

transferred from one medium to another. The printed picture will not match the sharpness 

of the image on your monitor, and further sharpening is necessary purely for the printing 

process. This is what Bruce Fraser called" output sharpening." 

Output or print sharpening needs 

to be done at the very end of the 

editing process, after the picture 

has been scaled to its final print 

size. This is important because 

sharpening is like a rim or halo 

around the edges within the 

picture, and remains effective yet 

imperceptible if it is around 1/100 

of an inch (0.25 mm) on the final 

output. If you correctly sharpened a 

picture and printed it at Letter or A4 

size on a 300 dpi inkjet printer, that 

sharpening rim would be too small 

to be effective if you then decided 

to resize the picture and make a 

smaller print. 

Right: Computer screens and printers 

have very different output resolutions. 

You should always evaluate sharpening 

by examining the final print. 
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HOW SHARP? 

Eyes 

Dar. .. 

Dar. .. 

Ii' II!';II Black & White 

Flipped 

Background 

Above: Always keep sharpening 

on its own layer. 

If you do need to resize your image, 

it can be best to create a temporary 

duplicate of your master file, resizing 

the image and sharpening it. This 

prevents you accidentally saving your 

changes, particularly resizing, to the 

master file. After you make your print, 

you can discard the duplicate file if you 

don't anticipate making further prints 

of that size in the future. 

Above: Correct print sharpening looks unacceptably 

coarse on your monitor at 100%. 

G 100% G 

Amount: � % 

Radius: � pixels 

�---------------------

Threshold: � levels 

�r------------------------

Above: A radius of 3 produces a print 

sharpening rim that is effective but not 

too obvious. 

In general, it is best to work on a 

copy layer-again, the principle of 

working non-destructively applies. Hide 

any border or even text layers so that 

they don't get sharpened too, and then 

hold down the Alt /"i: key as you select 

Merge Visible from the Layers palette. 

On this new sharpening layer, apply 

your preferred sharpening technique. 

A radius of 3 is generally good for 

300dpi printing since it equates to 

1/100 of an inch, and an amount of 

150-200% is a good starting point. 

Above: Zoom out to 25-50% to examine 

sharpening's impact on the image. 

You need to evaluate print 

sharpening by examining the print and 

not from the sharpening's on screen 

appearance. Your monitor has a lower 

output resolution than a printer and 

acceptable print sharpening usually 

looks brutal on a screen at 100%. It can 

help to zoom out to 25-50%, but even 

then you are still comparing apples with 

oranges-judge your sharpening by 

examining the final print itself. 
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PRINTERS 

The inkjet is by far the most common type of photographic printer and offers a great 

balance between quality and affordability. Manufacturers are continually updating their 

product ranges and it is difficult to keep up with the latest developments. Before buying, 

check reviews in photographic magazines and take advantage of the vast number of 

resources now available over the internet. Someone, somewhere will have already used 

the printer you are interested in, and will have posted an online review. 
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Left: With the right 

paper, with proper black 

and white ink, the quality 

of today's printers 

enables you to digital 

prints that can rival 

the beauty of a fine 

darkroom print. 



PRINTERS: INKJET 

Almost any inkjet printer can print a 

photograph, but for decent quality 

you need to look at the models that 

manufacturers produce specifically 

for photographic printing. These are 

more expensive, but their output 

quality is much higher-as in so many 

things, you get what you pay for. 

Photographic inkjet printers have more 

colors, usually 6 or 8 and in separate 

cartridges, while standard inkjets often 

only have cyan, magenta, yellow, and 

black, all in a single cartridge which 

has to be replaced as soon as one 

color runs dry. With extra colors, the 

more expensive photo-quality printers 

offer better color rendition. Most 

manufacturers now include extra 

grayscale cartridges such as light 

black for better mono reproduction. 

Right: Modern printers such as the 

Epson 2400 have additional ink 

cartridges for grayscale output and 

increasingly sophisticated drivers. 

PRINTERS: CONTINUOUS FLOW 

Some printers can accept continuous 

flow systems. These are often from 

third-party suppliers, sometimes from 

the printer manufacturer, and usually 

consist of self-standing ink bottles with 

tubes connecting them to the inkjet 

cartridges. After an initial cost, running 

costs are much cheaper and even 

relatively modest printing volume can 

justify the outlay. One big advantage 

is that you can use specialized black

and-white inks which the printer 

manufacturer may not produce. 

TIP 

Archival longevity should also be a 

major consideration. The better 

photographic printers tend to have 

inks based on pigments which tend 

to be much less susceptible to 

fading than dye-based inks. This is a 

fast-moving area, so it pays to 

review the specifications carefully 

when deciding to buy a new printer. 

Above: Many printers can accept 

continuous flow systems. These 

can reduce ink costs considerably, 

but involve initial setup costs. 
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NEUTRAL BLACK AND WHITE 
----------- -------

There's a certain irony in color being one of the biggest problems of black-and-white digital 

printing, and it's important to maintain a healthy scepticism when reading about new 

printers' black-and-white capabilities. The fresh print may look fine when it is viewed in 

daylight or with a daylight-balanced light, but it's a different story once you see the print 

under regular tungsten house lighting. What had previously seemed pure black and white 

suddenly exhibits a magenta color cast. or is occasionally greenish. The unwanted tone is 

different when the light source is fluorescent. and it also varies greatly depending on 

which paper you use. You can change your printer, and a lot of other things too, but a lot of 

photographers make the best of a bad job and discover a new enthusiasm for split toning. 
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SPLIT TONING 

There's an underlying technical obstacle 

here. For a color inkjet printer, printing 

a toned or split-toned black-and-white 

image is little different from color 

printing as it can blend the tone from 

half a dozen color cartridges, and 

then add black from one or more 

grayscale inks. But printing a neutral 

black and white presents a problem, 

even for a top-of-the-range printer. 

One or two grayscale inks are not 

enough to produce a smooth tone. 

To balance this the colored inks are 

also used, and the printer driver tries 

to combine them in a balance that 

results in a neutralized (gray) color. 

The output may look right in daylight 

but it's inevitably a compromise. 

Things are getting better. Printer 

manufacturers are introducing third and 

fourth grayscale inks so less use has to 

be made of colored inks cartridges. 

Drivers are also improving, though those 

from printer manufacturers tend to 

cover only their own brand papers. Even 

then, manufacturers' claims need to be 

put to the test. Check the print under 

normal house lighting and a faint color 

cast is often visible. 

Some photographers are happy 

with the mono output from third-party 

RIPs such as ImagePrint, OuadTone Rip, 

and Qlmage. These are replacements 

for the original printer drivers and have a 

range of specialist features like reducing 

ink usage, supporting a wider range of 

paper types, and print queuing. They 

also have black-and-white settings. 

But opinions differ. I've only ever 

been really satisfied by using dedicated 

black-and-white ink sets. These are 

available from companies such as 

Piezography, Lyson, and Permajet and 

are replacement cartridges or 

continuous flow systems. At their 

simplest, one swaps the black and 

white cartridges in and out as needed, 

taping over their nozzles when not in 

use. Because there is no need to 

compromise and use color inks, the 

results are much more neutral-simply 

black and white. 

Opposite: Specialized inks produce the 

most neutral black-and-white results. 

Warm neutral Cool neutral 

Above and Below: Specialized black and 

white inks are often based on carbon 

pigment and have carbon's warm 

undertone. They usually come in sets 

which let you add tonal variation. 

Neutral Cool sepia 
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CMYKOUTPUT 

Commercial repro printing is a specialized and highly skilled field. For many photographers, 

the whole topic of CMYK, the four-color printing process used by most commercial 

presses, has the mysterious status of a black art. CMYK needs the picture to be separated 

into cyan, magenta, yellow, and black components, from which four printing plates are 

made and attached to the press's rollers. Each then applies the appropriate ink color as 

paper passes through the press. While the computer can do the RGB-to-CMYK calculation, 

the screen's RGB image contains a wider range, or gamut, of colors than the press can 

accurately reproduce. These out-of-gamut colors will be clipped. Alternatively, the RGB 

colors need to be adjusted before the CMYK separation. 

That adjustment is usually made by 

the printer, not the photographer. 

Many pro photographers have 

never once been asked to submit 

CMYK-separated material, and that 

includes some acquaintances with 

40 years' experience. They hand 

over their pictures in RGB form, 

and their publisher or printer 

handles all the CMYK issues. For 

the photographer to perform those 

tasks would involve a major 

transfer of commercial risk and 

responsibility. From the perspective 

of those running the presses, 

generally the last thing they would 

want would be non-experts 

submitting erroneous attempts at 

CMYK color separations. 

While it is uncommon for the 

black-and-white photographer to 

handle CMYK separation and 

printing, Photoshop gives you a fair 

chance of doing a good job. It has a 

group of soft proofing tools that 

preview the gamut problems, so 

you can then decide exactly how 

the image's color range is 

compressed to remain within the 

range of colors that the printer can 

output. Any such work is usually 

best left to the very end of the 
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editing process since some familiar 

Photos hop features behave slightly 

differently in CMYK mode. So 

complete your regular editing work 

as normal, resizing the picture to its 

output dimensions and sharpening 

it, and save a master file in RGB 

format. Then prepare the CMYK 

version using a duplicate file. 

When you are taking 

responsibility for something so 

critical, it is important to 

communicate with the printer 

Above: Conversion issues particularly 

affect toned images. This picture's strong 

cyanotype-style color is too bright to 

reproduce properly on a CMYK press. 

and keep proper documentation. 

Plan to submit both the RGB and 

the CMYK files, accompanied by 

an inkjet print for reference. 

Opposite: The final output stays sharp 

with manually adjusted CMYK channels 

for better definition of colors that were 

out of gamut after RGB conversion. 

Below: CMYK separates the picture 

into cyan, magenta, yellow, and black 

components and is used in most 

commercial printing presses. 

Clrl+-

(Irl+1 

(Irl+2 

(Irl+3 

Ctrl+4 
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COLOR MANAGED CONVERSIONS 
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D As with all advanced work, it is 

important to make sure your 

monitor is calibrated and profiled, and to 

set Photos hop's color settings so they 

are correct for the printing press, In the 

USA that would generally mean choosing 

North America Prepress 2, but this varies 

by country and it is best to seek written 

confirmation from the printers, 
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EJ To see if your RGB image contains 

any colors that are out of gamut, 

set up Photoshop's soft proofing for the 

specific type of press which will be 

used, While you can pick View> Proof 

Setup and then choose Working CMYK, 

a more sophisticated choice is Custom 

which lets you fine-tune the settings, 

The Device to Simulate signifies the 

press type, SWOP or Standard Web 

Offset Press is one US standard, but 

you should place the responsibility on 

the printer to supply the correct profile 

for their equipment, especially if the 

printer uses sheet-fed presses, For 

Rendering Intent. choose Relative 

Colorimetric, which will clip any colors 

but preserve brightness values, Then 

make sure you save your settings, 
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ft Switch on soft proofing by 

U selecting View> Proof Colors, 

and switch on View> Gamut Warning, 
This enables a preview mode that 

shows what will happen to your RGB 

colors after you make the image CMYK, 

A gray overlay marks out-of-gamut areas, 

, ,. ' ' £1 
, .�: t ' " 

o .<",� 
f..� 
J( 

Above: Photoshop's Gamut Warning 

makes it very obvious when RGB colors 

are out of the CMYK press's gamut or 

printable range, 



a With Photoshop's Gamut Waming 

active, you can add a Hue/ 

Saturation adjustment layer and reduce 

the saturation while watching its effect 

on the RGB image's colors. Here I have 

begun to drag the overall or Master 

saturation to the left and this has 

reduced the out-of-gamut areas. The 

Edit drop-down box also lets you adjust 

individual colors, which may be useful if 

you are working with a split-toned 

picture. Alternatively, use a Selective 

Color adjustment layer. 

Select: IIOut Of Gamut 11"'1 - c::QO 
Fuzziness: n � 

Selection Preview: I Quick mask I ..... ] 

o Invert 

... You can also target specific image 

U areas with the color adjustments. 

Before adding the adjustment layer, go 

to Select> Color Range and pick Out Of 

Gamut. When you add an adjustment 

layer, it is automatically masked. 

ft The adjusted colors will not 

... usually be as sparkling as in the 

original AdobeRGB or ProPhotoRGB 

image, but you should be able to adjust 

a toned black and white so that the 

colors are acceptable and can be 

reproduced on the CMYK press. Once 

you are satisfied with the soft proof, 

Image> Mode> CMYK is the quick 

way to make the CMYK version and 

applies Photoshop's current settings to 

the picture. 

I 
Source Space 

I Profile: Pro Photo RCB 

Destination Space 

Profile: I U.S. Web Coated (SWOP) v2 

Engine: 1 Adobe (ACE) Ivl 
Iment: I Relative Colormetric [ .... 1 

0Use Black Point Compensation 

0Use Dither 

r Conversion Options 

Flatten Image 

IJ For more control, choose Edit> 
Convert to Profile. This also lets 

you review the settings that will be 

applied. Generally one chooses Adobe 

(ACE) as the Engine and Relative 

Colorimetric as the Intent. Black Point 

Compensation should also be ticked so 

Photoshop matches the output black to 

the image's black. Allow Photos hop to 

flatten the image, make sure your 

copyright and content details are in the 

file, and save it as a standard TI FF. 
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BLACK AND WHITE IN BULK 
Most of this book has focused on making the best individual black-and-white image. 

"Best" is judged in terms of quality, and in terms of using the mono conversion creatively, 

so the final work has made the most of the captured image data and presents the best 

subjective interpretation of the subject. It is an approach suited to one-off jobs, and is 

perhaps indicative of a fine-art mentality. 

ACTIONS 

But more and more photographers also 

want black and whites not just of the 

day's best few shots, but of every frame 

worth keeping that day. Given how 

quickly some cameras can fill flash 

cards, the one-off, fine-art approach 

could amount to an awful lot of 

Photoshop time. Essentially there 

are five possible solutions: 

• Shoot black-and-white 

RAW+JPEG 

• Process color RAW files with a 

Photoshop Action 

• Process color RAW files 

through a RAW converter 

• Use a cataloging program to 

output in black and white 

• Use new-generation combined 

cataloging and RAW processing 

programs such as Lightroom 

and Aperture. 

For sheer efficiency, choose the 

RAW+JPEG shooting setting if your 

camera has one, and set it to black-and

white mode, too. Once the pictures are 

on your computer, all you then need to 

do is get all the pictures into one Finder 

or Explorer folder and sort them by file 

type. Of course, you will have to make 

this decision before you press the 

shutter release. 
A Photoshop Action is a way of 

recording editing steps so they can later 

be replayed and applied to other 

images. To set up a black-and-white 

conversion Action, open an image and 

start a new Action in the Actions 

palette. Add a Black and White 

adjustment layer, a sharpening layer, and 

maybe a border, then save the file and 

close it. Click the Stop playing/recording 
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I Overlay �JOpacity 180% �I 

Lock: lliId + 8 Fill : 1100%: [J 

[if I'�I Platinum tone 

Iii 1---,.-1 Channel Mixer 1 

Sharpening 

Background � 

Above: A Photoshop action can add 
adjustment lavers and be an efficient way 
to process lots of pictures consistentlv. 

button in the Actions palette, and the 

Action is ready. You can now open the 

next color picture, run the Action, and 

proceed through all the images. 

You could also introduce user input 

into the Action. For instance, tick the 

column to the left of the Black and 

White adjustment layer step, and the 

Action will pause each time it is run, 

enabling you to adjust the sliders to 

Below: Actions let you replav your editing 
steps and can be paused for user input. 

� � � CJ Default Actions 

fJ -a- � D John's 

� r � D Effects - John's 

fJ � � D Toning 

� � V eJ Black and White 

� � V Make b&w, sharpen and tone 

� layer Via Copy 

� I � High Pass 

� I '" Set current layer 

To: layer 

Mode: overlay 

� I '" Set current layer 

To: layer 

Opacity: 80% 

� .� '" Make adjustment layer 

Using: adjustment layer 

Type: black and white 

Preset Kind: Factory Preset 

Using: C:\Program Files\Adobe\A ... 

� I '" I Make; adjustment layer 

Using: adjustment layer 

Name: "Platinum" 

Type: curves 

Adjustment: curves adjustment Jist 

curves adjustment 

Channel: red channel 

CUlve: point list 

point: 0, a 

point: 63, 7S 

suit each image. Alternatively, if you 

simply want to leave the computer 

processing multiple images, you can 

select them in Bridge and set off the 

Action using the command Tools> 
Photoshop > Image Processor. 

Photoshop Actions work well once 

you have set them up and tested them, 

and when your editing work involves 

little variation. Little things, like dealing 

, 



--------------------------- ---------

Above: Camera Raw's Stack Mode can 

work on many images at once. 

differently with portrait and landscape 

format images, can prove awkward, 

even for photographers adept at 

automating their workflow. Others 

struggle and find Actions, let alone 

Photoshop scripting, a concept and 

discipline they never quite grasp. 

Another approach is to use the 

RAW processor. This could be done 

equally well using Bibble, Nikon 

Capture, Capture One, or another 

standalone RAW converter, but it is 

quite easy in Bridge. Select the RAW 

files, then right-click and choose Open 

in Camera Raw. As we saw in the 

section on black-and-white conversion 

techniques, Adobe Camera Raw version 

4 has a specific grayscale output option 

and accompanying sliders. You can 

select all the images and apply identical 

settings, or fine-tune each picture. Do 

not click Open, but choose Save, and 

you will be prompted for a folder and 

format for the output. When Items 

Remaining has counted down to 0, click 

Cancel so that your black-and-white 

conversion settings do not overwrite any 

existing color RAW conversion settings. 

Cataloging and photo-organizing 

programs can often output black-and

white from color images. In this 

category are consumer-oriented 

packages like iPhoto on the Mac and 

Picasa on the PC, and more pro level 

DAM (digital asset management) tools 

such as iView/Expression Media. These 

programs include basic controls for 

black-and-white output and special 

effects like sepia toning and vignetting. 

They may be geared more toward 

convenience than professional quality, 

but they're great if you are using them 

to manage and find your pictures and 

need a lot of black and whites in a hurry. 

Above: iView Media Pro is a multimedia 

cataloging tool with photographic tools. 
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RAW LIBRARY SOFTWARE 

Another option emerged at the turn of 
2005/2006 when Apple and Adobe each 
released ambitious new programs 
combining top-quality RAW image 
processing with pro-level DAM features. 
Apple's Mac-only Aperture and Adobe's 
Lightroom, which runs on both PC and 
Mac, aim to meet photographers' need 
to organize, adjust, and output large 
number of pictures. While it is too early 
to say how far these "workflow" 
programs will reduce photographers' 
use of Photos hop, both contain 
adjustment tools that can accomplish 
many of the main tasks, and they are 
designed particularly for working with 
many pictures at once. Each can 
produce excellent black and whites. 
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Left: Adobe Lightroom, like Apple Aperture, 

saves alternative versions of vour files. 

Thev are "virtual copies" that exist onlV in 

the database until vou print or output them. 

Below: Librarv's Quick Develop panel is a 

fast wav to applv preset black-and-white 

conversion recipes. 

Left: Lightroom's Develop module offers 

fine control of how colors are rendered in 

gravscale tone. 

At the time of writing, Lightroom 
offers the more sophisticated control 
over black and white. In its Library you 
can select any number of images
hundreds, if you want-then right-click 
one and select Create Virtual Copies. 
This makes Lightroom add duplicate 
thumbnails to its database, which you 
can use for the black-and-white 
versions, leaving the color versions 
untouched. You can also press Ctrl/O+N 
and put the virtual copies into a new 
Collection with the name of your choice, 
so they are easy to find later. 

To make these thumbnails black and 
white, the quickest way is to click the 
Quick Develop panel (F8) on the 
screen's right, and choose Grayscale 

from the Preset drop-down. Lightroom 
updates all the selected thumbnails with 
default black-and-white treatments. 

But much finer control is available in 
the Develop module. Keeping the 
thumbnails selected, press the D key to 
switch to Develop, and then activate the 
Grayscale panel at the right of the 
screen (F8). This panel's controls work 
in a similar way to the Black and White 
adjustment layer in Photoshop CS3. You 
drag individual sliders to change a 
color's grayscale rendition, or use a 
Targeted Adjustment Tool so you 
change slider values by dragging the 
cursor directly across image areas. 



-------------- --------------

Auto Sync Reset 

� 

Above: In Lightroom, switch to Auto Sync 

mode to apply your adjustment to all the 

selected images. 

Develop's sliders usually adjust only 
the picture that is currently shown on 
screen. To apply those adjustments to all 
selected images at once, press the Sync 
button. Lightroom lets you decide which 
adjustments to apply--for instance, you 
may not wish to apply the same crop or 
dust correction to all the pictures. 

But there is an even more efficient 
way to work in Develop--hold down the 
Ctrl(cJ key and click the Sync button. 
This switches Develop into Auto Sync 
mode, which means your slider 
adjustments now apply to all selected 
images. I always work in this mode, 
selecting a sequence of similar images 
in the Filmstrip (F6), adjusting the 
sliders, then selecting the next group of 
pictures, and so on. 

As well as fine-tuning black-and
white output, in Lightroom you can 
change contrast, sharpen, or apply split 
toning to multiple images. You can then 
send them all to the printer, burn them 
to a disc, or output them to the web. 

Right: Lightroom's black-and-white 

conversions are applied to the entire picture. 

Individual shots must be sent to Photoshop 

if they need more than one conversion 

adjustment, or require dodging and burning. 
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B 

APERTURE 

Apple's Aperture is also designed for 

adjusting the overall appearance of 

multiple pictures, not working 

Photos hop-style on one image at a time 

or manipulating images at pixel level. 

Like Adobe Lightroom, the Aperture 

workflow involves making virtual 

versions of your pictures. In the 

Browser view, select the thumbnails 

and choose Image> Duplicate Version. 

While Aperture automatically adds a 

version name, which will make it easier 

to find these new versions at a later 

date, it still makes sense to change the 

version name to something more 

useful, such as the master filename and 

a suffix. You can do this in Metadata > 

Batch Change. 
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Then display the Adjustments 

palette (AA) or go into full-screen mode 

(F) and bring up the Adjustments heads 

up display (H). From the palette or HUD 

menu, choose Monochrome Mixer and 

you have access to a set of sliders 

which work like Photoshop's Channel 

Mixer. You can apply negative values to 

one or more channel, but ideally the 

three sliders should add up to 100%. 

There is also a Color Monochrome 

adjustment so you can apply a single 

tone to the image, though there is no 

split-toning adjustment. 

Once you have converted one image 

to black and white, you can apply those 

adjustments to multiple images using a 

Lift and Stamp tool, which works just like 

Left: Apple's Aperture has a 

Monochrome Mixer that works 

like Photoshop's Channel Mixer. 

Left: After fine-tuning one image, 

you can "lift and stamp" your 

adjustments to the others. 

regular copying and pasting. This needs 

to be done sensibly-the same mono 

conversion isn't right for every image

but it is very efficient for adjusting 

batches of pictures. 

At the time of writing, Aperture's 

range of black-and-white controls is 

some distance behind Lightroom. But 

these programs are in direct competition 

and their features will develop quickly. 

Either application is already a viable 

option for bulk black-and-white work. 



Right: Aperture is 

ideal for producing 

high-quality black

and-white output and 

working with large 

numbers of pictures. 
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OUTPUT FOR THE WEB 

The web is an increasingly popular means of displaying your work and there IS a 

corresponding increase in the number of ways to do so. You can upload pictures to various 

I photosharing and stock services, maintain your own site, or send pictures to a web 

designer. But regardless of which method you choose, you need to ensure your images 

look their best online, and make it as difficult as possible for people to steal your work. 

Preparing images for the web 

should be done after completing all 

other work on a picture. So you 

don't overwrite the master file and 

lose all your adjustment layers, it 

can make a lot of sense to use a 

temporary duplicate for your web 

preparation work. Then resize the 

images, apply an appropriate level 

of sharpening, set a correct Color 

Profile, add a copyright logo, and 

last of all, check the pictures have 

the right metadata. 

Right: Include your name in your copyright 

watermark. It will take a copyright thief so 

much time to remove this notice that it will 

act as a deterrent. But be careful not to 

offend legitimate visitors. 
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SWITCH TO sRGB 

When you're checking the pictures 

you've uploaded to your web site, you 

may notice that the colors look washed 

out in comparison to their original 

appearance in Photos hop. While this is 

not such a big issue for black and 

whites, it can still affect toned mono 

work. The reason for this is that web 

Below: Convert your images' color 

profile to sRGB before putting them 

online. Most web browsers are not 

color-managed and your visitors will see 

tones that are much less saturated. 

browsers are not color-managed (at 

the time of writing, the Mac-only Safari 

is the sole exception) so there is little 

point saving your ICC profile with the 

file and hoping that Safari is the only 

browser used to view your pictures. 

You need to allow for the lowest 

common denominator online, so 

choose Edit> Convert to Profile and 

switch your picture's color profile so 

sRGB. You may then need to adjust 

the color saturation, but this will 

ensure your site's visitors see your 

pictures at their best. 

HOW MANY PIXELS? 

Until recently, the " right" size 

for the web made the best use 

of limited bandwidth and online 

storage space, but today the 

bigger considerations are the 

screen sizes which you expect 

your visitors will use to view your 

work, and the security of your 

pictures. You cannot assume that 

your visitors will only use 30 inch 

screens, or have the same-sized 

monitor as you. You need to target 

a much lower screen size and 

make web output no larger than 

1000 pixels. Also remember that 

screens are wider than they are 

tall, and visitors to your web site 

should not need to scroll the 

browser to see the bottom of a 

picture in portrait format. 

While you clearly want your 

work to impress, security is the 

other main reason for limiting the 

dimensions of web output. It is a 

common fallacy that Flash-based 

web sites protect your work 

better than HTML-based sites. 

A visitor can always take a screen 

grab (sometimes for legitimate 

reasons like shortlisting your 

pictures in a proposal). So, other 

than not putting work online, 

ultimately you cannot stop the 

determined thief. Instead, you 

need to increase his cost in terms 

of time and manual effort, and 

reduce the potential gains. So the 
smaller the image, the less useful 

it is to steal. At 600 pixels wide, 

someone could only make a 

decent 2 inch (5 cm) print at 300 

dpi, but the temptation obviously 

increases once you put larger 

images online. 
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SHARPEN THE IMAGE 

After resizing the image and adding a 

border if required-but before you add 

any copyright notice-the next step is 

to sharpen the picture for web output. 

Unlike print sharpening, where the 

printer's different output resolution 

means sharpening often looks 

gruesome on screen, the output 

medium for web images is your visitor's 

monitor. So, broadly speaking, your own 

screen is fine for judging how much 

sharpening to apply for web use-just 

make sure you apply sharpening with 

Photoshop zoomed in to 100% or actual 

pixels. Set the Radius to below 1 pixel. 

184 PRESENTATION AND OUTPUT 

0.7 is good and at a typical 72dpi 

monitor resolution roughly equates to 

1/100inch (0.25mm) or the same-sized 

rim as for print sharpening. Also, if use 

the Unsharp Mask, make sure you 

immediately follow it with Edit> Fade 

Unsharp Mask and select Luminosity as 

the blending mode. This prevents any 

colored artifacts. 

G 100% G 

Amount: I � 1% 
�----------�Or----------

Radius: � Pixels 

�r----------------------
Threshold: � levels 

Or------------

G 100% G 

Amount: � % 

o Preview 

�----------------�a----
Radius: I M I pixels 

r---Qr---------------------
Threshold: CJ levels 

a 

Left: Unlike sharpening 

for print, your monitor 

is a good guide for the 

final result online. 

Left: Too much 

sharpening creates 

an unsightly halo 

around image edges. 



ADD COPYRIGHT NOTICES 

As well as limiting the size of your 

images, you should also add a visible 

copyright notice that includes your 

name. Its size is obviously a judgement 

call-you don't want to deface your 

work too much or treat all visitors as 

dishonest. But it needs to be obvious 

enough to stop legitimate users making 

mistakes and also deter casual copying. 

Most of all, the larger the copyright 

notice, the more time the thief would 

need to spend Photos hopping it away. 

Again, it's a case of deterrence rather 

than complete protection. 

8< [ J ... ja, • • 
A 1'-

� + (S) • � iii 
r-

rm --
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• 0 D ©� 

l® TM � 
Above: You can use one of Photoshop's 

built-in shapes for a copyright symbol. 

1 Normal [VI Opacity: 1100% [I] 
Lock: D.:J" + a 

©2007 John B... ftc 

§It Effects 

� Bevel and Emboss 

Background 

ADD INVISIBLE METADATA 

As well adding a visible copyright notice 

to the image, you can take invisible 

measures to deter theft and prove your 

ownership of an image. Photoshop's 

File> File Info command lets you check 

that your images contain your copyright 

and contact meta data before you upload 

them. Ideally, such information would 

have been added when you transferred 

the pictures from your camera to 

your computer, using Bridge or a 

cataloging program, but in practice the 

information can easily get stripped 

away-by Photoshop's own Save for 

Web command, for instance. Instead, 

Photoshop's Save As command 

preserves metadata, but be aware that 

this includes camera-generated EXI F 
information such as the camera model, 

shutter speed, and other information 

that you may not wish to include. 

It is best to do a final check using 

Photoshop's File> File Info command, 

and it is a good idea to set up a 

metadata template that contains your 

copyright and contact information. The 

determined thief can always remove 

these details, but at least you are tipping 

the cost/benefit balance in your favor. 

CQPYri9hISt.llU1: ICoPY'!9htt'd 1 ... 1 
COpyrighlNOlkf: CI8!il?lO!iIi)iin:tiWOiil! 

CopyrighllnFo wu.: �np'lI ,burdswonh.{o.uk 

('Uled: H{09/l005JO:IO:Z7 
Modined: 17fOl/1OO717:S9:12 

AppUulion: Ado�l'tIo101hopCS1Wl''dows 
formn: �ppliuUO",'o'IId..tdobe.pholo,hClp 

Left and Above: Use layer styles and 

reduce the Fill opacity to 0% for a neat 

transparent effect. 

Below: Photoshop's File 

Info panel lets you add 

invisible information 

about the picture. A 
determined copyright 

thief could remove this, 

but legitimate users of 

your work would not 

normally do so. 

SaW<! Mfl.dn" empl;ne ... 
tkle"�Ud.ltlTern�lt .•• 

StlowTtmpbln ... 
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GLOSSARY 

ACTION Photoshop keystrokes 

recorded to automate routine activity. 

ADJUSTMENT LAYER A layer in a 

Photoshop image that adjusts the 

appearance of layers beneath it, and 

keeps editing adjustments separate 

from image data. 

ALIASING Jagged edges in a digital 

image, caused by the square shape of 

its constituent pixels. 

ALPHA CHANNEL A grayscale version 

of the image that can be used with 

the color channels for saving a mask 

or selection. 

ANTI-ALIASING Smoothing jagged 

edges by introducing additional pixels 

of intermediate tone. 

APPLE APERTURE Image editor 

introduced in 2005 by Apple 

Computer and combining DAM 

features from cataloging programs 

and RAW image processing. 

ARTIFACT Foreign shapes degrading a 

digital image as a result of its capture, 

manipulation, or output. 

BITMAP An image consisting of a grid 

of tiny pixels, each with color and 

brightness values. 

BLENDING MODE The calculation that 

controls how one Photoshop layer is 

composited with other layers. 

BLOWN OUT Containing no detail, 

usually referring to overexposed parts 

of an image. 

BRIGHTNESS Subjective impression of 

luminosity. 

BROWSER A program that examines 

folders in real time, displays image 

files' thumbnails and large previews, 

and allows metadata entry. Searches 

are performed by examining the file 
system. Examples include Bridge, 

Photomechanic, Breezebrowser. Also 

used as shorthand for Web Browser. 

BURN A photographic darkroom and 

Photos hop technique to darken part 

of the image. 

BURNT OUT Containing no detail, 

usually referring to overexposed parts 

of an image. 

CATALOG A program that records the 

contents of folders, displays image 
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files' thumbnails and large previews, 

and allows metadata entry. While 

folders may be shown, their contents 

are not updated in real time but only 

when instructed, and searches are 

performed upon the database. 

Examples include Extensis Portfolio, 

iView MediaPro, iMatch, and 

ACDSee. 

CAMERA RAW In Photos hop, the 

module responsible for converting 

RAW images from any digital camera. 

CHANNELS The three colors whose 

brightness values are used to record 

the color of a pixel. 

CLIPPING An absence of detail in 

image areas because the brightness 

values record either complete black 

or pure white. 

CMYK Cyan Magenta Yellow Black

the subtractive model of defining color. 

COMPRESSION Reduction of image 

size by use of algorithms to discard 

superfluous data. 

CONTINUOUS FLOW SYSTEM A system 

of bottles and tubes that supplies ink 

to the printer. 

CONTRAST Difference in brightness 

between neighboring areas. 

CURVES In Photoshop, a method of 

mapping pixels' brightness values to 

the value at which they are output. 

DEPTH OF FIELD The area in 

acceptable focus, in front of and 

behind the point at which the lens is 

focused, and varied by opening and 

closing the aperture. 

DERIVATIVE An image file produced 

from an original, for instance the 

JPEG or PSD file saved after a RAW 

or DNG original has been edited in 

Photoshop. 

DESTRUCTIVE Permanent change of 

pixels' brightness values or positions. 

DIGITAL ASSET MANAGEMENT The 

practice of downloading, backing up, 

evaluating, describing, categorizing, 

selecting and archiving digital image 

files. 

DODGE A photographic darkroom and 

Photoshop technique to lighten part 

of the image. 

DPI Dots per inch, the standard 

measure of resolution. 

DYE A type of ink that soaks into the 

paper. 

EXIF Commonly refers to exposure 

information stored with digital image 

files; strictly refers to the file format. 

F-STOP The ratio of the focal length to 

the aperture diameter, expressed as 

12.8,14 etc. 

FEATHERING In Photoshop, making 

the edges of a selection softer. 

FILTER (PHOTO) Transparent material 

which changes the light passing 

through it. 

FILTER (SOFTWARE) A Photoshop 

adjustment to the brightness values 

of image pixels. 

FOCAL LENGTH The distance between 

the center of the lens and the focal 

point. 

FOCAL POINT The point at which light 

rays passing through a lens converge. 

FOCUS Where light rays converge on 

the sensor and form a sharp image. 

GRADIENT Smooth blending of one 

color to another. 

GRAYSCALE An image containing 

pixels with brightness values only on 

a black-and-white scale and with no 

color data. 

HIGHLIGHT The brightest tones in an 

image. 

HISTOGRAM A chart showing how the 

distribution of pixels by brightness 

value. 

ICC PROFILE A measure of a digital 

imaging device's color characteristics, 

used for accurate communication of 

color between devices. As set by the 

International Color Consortium. 

IMAGE MODE Method of recording 

color and brightness in a digital image 

file. 

INTERPOLATION The addition or 

deletion of pixels when Photoshop 

resizes an image. 

ISO Measure of sensitivity to light 

(" speed") as set by the International 

Standards Organisation. 
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JPEG A digital image file format 

which compresses file size by the 

removal of unused color data. 

LASSO A Photoshop tool to select 

image areas. 

LAYER In Photos hop, a level of the 

image file to which changes can be 

independently applied. 

LCD Liquid crystal diode, used to 

refer to the screen on the back of 

digital cameras. 

LlGHTROOM Image editor introduced 

in 2006 by Adobe combining DAM 

features from cataloging programs 

and RAW image processing. 

LOSSY A file format which discards 

image information to create a smaller 

output file. Opposite of lossless. 

LUMINOSITY The quantity of light 

reflected by or emitted from a 

surface. 

MACRO A type of lens capable of 

closeup photography at more than 

1:1 magnification. 

MARQUEE A Photoshop tool used to 

select image areas. 

MASKING Blocking parts of an image 

from light, or in Photoshop excluding 

parts of layers from the composite 

image. 

MIDTONE The average luminosity 

parts of a digital image. 

NEUTRAL DENSITY Uniform density 

across the visible wavelength and of 

no color. 

NOISE Random pixels on a digital 

image. 

PIGMENT A type of ink consisting of 

particles that lie on top of the paper. 

PIXEL Picture element, the smallest 

unit of a digital image. 

RAW FILE The image data recorded 

by a digital camera's sensor in the 

camera maker's proprietary file 

format and containing the unchanged 

image data and one or more 

embedded JPEG thumbnails and 

previews. 

RESOLUTION The level of detail in an 

image, measured in pixels or dots per 

inch. 

RGB The primary colors of the 

additive model of recording color, 

used for recording image colors on 

monitors and in image editing. 

SATURATION The purity of color, with 

high saturation being most intense. 

SELECTION Part of a Photoshop layer 

selected by the user and marked by 

the "marching ants" dotted lines. 

SHADOWS The darkest tones of an 

image. 

SHUTTER Camera mechanism that 

controls the time that the sensor or 

film is exposed to light. 

SLR A camera that shows the same 

image directly through the viewfinder 

as on the sensor or film. 

SMART FILTER From Photoshop CS3, 

a filter applied to a Smart Object layer 

and altering its appearance. Unlike 

earlier uses of filters, its effect can be 

reversed or adjusted at any time. 

SMART OBJECT A protected layer in 

Photoshop (CS2 onward) whose 

appearance may be adjusted or 

distorted without changing or losing 

the underlying image data. 

SOLARIZATION Usually the same as 

Sabattier effect but strictly an effect 

caused by greatly overexposing film 

emulsion. 

SPLIT TONE The addition of one or 

more tones to a monochrome image. 

'STOP See !stop, also used as the 

action of closing the aperture, as in 

"to stop down." 

TIFF Tagged Image File Format, a file 

format for high-resolution graphics, 

widely compatible with other 

operating systems. 

UNSHARP MASK A process which 

increases the apparent detail of an 

image by computer manipulation. 

WHITE BALANCE Automatic 

compensation for the color 

temperature of artificial light. 

FURTHER READING 

Ansel Adams The Negative 

Ansel Adams The Print 

Don McCullin Sleeping with Ghosts 

Don McCullin Unreasonable Behavior 

Patricia Morrisroe Mapplethorpe 

A Biography 

Eddie Ephraums Creative Elements 

John Paul Caponigro Adobe Photos hop 

Masterelass 

Martin Evening The Adobe Photoshop 

Book for Digital Photographers 

John Beardsworth Lightroom 

Essentials 
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Adobe 

httP//www.adobe.eom 

Russell Brown 

http//wwwrussellbrown.eom/ 

Aperture 

http//wwwapple.eom/aperture/ 

Permajet 

http//www.permajet.eom/ 

Lyson 

http//wwwlyson.eom/ 

Piezography 

httP//wwwpiezography.eom/ 

QuadTone RIP 

http//wwwquadtonerip.eom/ 

Heidelberg Druckmaschinen 

http//www.heidelberg.eom/ 
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automatic settings 36 127,139,159 
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99,101,131,147,161 bulk images 176-81 

Background Layer 45, 50 burning 27, 55, 71, 73, 90, 

backup procedures 114 92-101,117,124,143, 
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Batch Change 180 burnt-out highlights 24, 86 

best practice 40 
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175 Canon 35 
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Capture 58 

Capture One 58, 177 
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cartridges 169, 171 

cataloging programs 
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Color Balance 114 

color casts 30, 35, 37, 

170-71 

color channels 17, 31, 41, 

43-44, 46-47 

Color Fill 43, 127 

color images 14-15 

Color Intensity 42 

Color Libraries 117 

color managed conversions 

174-75,183 

Color Monochrome 180 

Color Range 123, 131, 

147-49, 172 

Color Sampler 118-19 

color settings 174 

color values 43 
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commercial repro printing 
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copyright 175, 182, 184-85 

Create Virtual Copies 178 
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86-87 

Crop 159 

cropping 27, 143, 160-61, 

179 
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CS2 58 

CS3 52-53, 58, 61, 68, 77, 
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132, 141, 1 52, 178 

cursor 52, 55-56, 64, 71, 
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143,153,163 
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Load 117 nanometers 35 105, 109, 112-14, 116, 

local contrast 84-85 The Negative 31 118-19, 122-23, 126, Radius 85, 103-5, 184 

logos 182 neutral black and white 128, 130-32, 134-37, rasterizing 149 

lossy compression 12 170-71 140-41,144,146,148, RAW+JPEG shooting 

low key 150 neutral density filters 152,156,158-61,172, setting 176 

luminosity 25, 41, 86, 103, 32-33 174-76,178, 180, 183-85 RAW format 12-15, 22, 25, 

135,184 neutral graduated filters 32, Photos hop Action 176-77 28,30-31,58,60-61,88, 

Lyson 171 97 Picasa 177 102, 176, 178-79 

night vision 34 Piezography 171 RAW processors 176-77 

M curve 133 Nikon 35,58 pigments 169 Ray, Man 132 

McCullin, Don 92, 138 Nikon Capture 177 pinhole cameras 142-43 RealGrain 141 

McCurry, Steve 16 noise 22-23, 25, 86, 108, pixels 183-84 rebates 160-61 

Macs 141, 177-78, 183 138-39 plan-do-review cycle 36 recording in action 133-34, 

Magic Wand 109 NoiseAware 25 plane of movement 143 136 

manual exposure 35 NoiseNinja 25 plastic filters 32 rectangular format 156 

manuals 35 North America Pre press 2 platinum 120 Red channel 46-47, 49, 62, 

manufacturers 168-69, 171 174 plug-ins 25, 58, 140-41, 67-69,113,115,119-21, 

Mapplethorpe, Robert 16 nudes 16 144,157 123,130,135 

Marquee 95, 143, 163 Point Sample 119 reference prints 172 

masks 28, 40, 48-49, 55, one-off jobs 158, 176 pointillism 138 reflections 33 

62,64-65,68,71,73,83, Open Object 61 polarizing filters 32-33 regrouping 28 

88,91-95,97,99,101, optical blur 104 Polaroids 20 Relative Colorimetric 

109,113,116-17,124, out-of-gamut areas portraits 57-58, 69, 98-99, 174-75 

127,130-31,139,141, 174-75 138,150,164,177,183 remote· controls 35 

143,148-49,161 output 154-85 post processing 22-23, Remove 104 

Match Color 42, 118 output sharpening 102, 27-28,35,88 Renaissance 144 

matte 156 166-67 posterization 23, 28, 91 Rendering Intent 174 

measured tone 118-19 overexposure 20, 23, 32 Power Retouche 141 replacement cartridges 171 

memory cards 12,14 Overlay 92-93, 105, 131, Preferences 46 reportage 78, 100-101, 

men 58, 69, 98-99 133,135 presentation 154-85 138 

Merge Visible 85, 103, 132, presets 12, 35, 53, 56-57, repro printing 172 

167 palladium 120 68-69, 71, 73, 91, resin filters 32 

meta data 180, 182, 185 PanF 140 113-14,117,130, resizing 123, 161, 166-67, 

metering 29, 33 paper 27, 76, 82, 90, 141,147,159,178 172,182-84 

midtones 15, 28, 57, 120-23, 134, 140, 156, previews 14, 45, 49, 53, resolution 102, 138, 147, 

78-81,97,99,114-15, 168-71 60,65,131,172,174 161,167,184 

119,133,135,143,149, partial conversion 124 primary colors 112 retouching 44-45, 58, 103 

163 partial tone reversal 132-33 printers 166, 168-71, 179 reviews 27, 36, 168-69, 175 

190 FURTHER INFORMATION 


